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l. Letter from the Chairman of the Ministers’ Deputies to the President of the Assembly, dated
2 July 2015
[translation]

| have the honour to refer to the procedure for the appointment to the post of Secretary General of the
Parliamentary Assembly and to inform you that the Ministers’ Deputies, at their 1232rd meeting on 1 July
2015, adopted the enclosed resolution submitting the following candidatures in alphabetical order:

- Ms Svetislava Bulajic;
- Mr Wojciech Sawicki.

Signed: Almir SAHOVIC
Chairman of the Ministers’ Deputies

Il. Resolution CM/Res(2015)8
on the appointment to the post of Secretary General of the Parliamentary Assembly
(Adopted by the Committee of Ministers on 1 July 2015 at the 1232nd meeting of the Ministers’
Deputies)

The Committee of Ministers, under the Regulations relating to the appointment of the Secretary General,
Deputy Secretary General and Secretary General of the Assembly having the rank of Deputy Secretary
General,

Having taken note of the letters addressed to the Secretary General by ten representatives of the
Parliamentary Assembly and by the Minister for Foreign Affairs of Poland proposing the election of
Mr Wojciech Sawicki as Secretary General of the Parliamentary Assembly;

Having taken note of the letter addressed to the Secretary General by the Minister for Foreign Affairs of
Serbia proposing the election of Ms Svetislava Bulaji¢ as Secretary General of the Parliamentary Assembly;

Having interviewed the two candidates;

Having consulted the representatives of the Assembly through the medium of the Joint Committee held on
25 June 2015,

Decides to submit to the Parliamentary Assembly, for appointment to the post of Secretary General of the
Parliamentary Assembly, for a five-year term starting on 1 February 2016, the following candidatures in
alphabetical order:

- Ms Svetislava Bulajic;
- Mr Wojciech Sawicki.
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I, Candidatures
Candidature of Ms Svetislava BULAJIC

The Secretariat recalls that, on 18 and 19 March 2015 (1223rd meeting of the Deputies, item 1.5), the
Deputies adopted the timetable concerning the procedure for the election of the Secretary General of the
Parliamentary Assembly. In that timetable 12 May 2015 was fixed as the closing date for the submission of
candidates and 3 June 2015 (1229th meeting of the Deputies) was fixed as the date for the preliminary
examination of candidatures by the Deputies.

On 13 May 2015, the Secretary General forwarded to the Committee of Ministers the candidature of
Ms Svetislava Bulaji¢, member of the Presidency of the Serbian Constitutional Law Association.

The Secretary General appended to that communication a copy of a letter addressed to him on 11 May 2015
by the Permanent Representation of Serbia, and a letter from the Deputy Prime Minister and Minister of
Foreign Affairs, Mr lvica Daci¢, proposing the candidature of Ms Bulajié.
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PENYBJHKA CPEHJIA
[PBA NNOTNPEACEOHUK BJIALIE
U MUITUCTAP CMOJLHUX TMTOCJIOBA

Dear Mr. Secretary General,

Ahead of the election of a new Secretary General of the Parliamentary
Assembly of the Council of Europe (PACE) to take office on 1 February 2016, I
would like to nominate, on behalf of the Republic of Serbia, Ms Svetislava Bulaji¢,
member of the Presidency of the Serbian Constitutional Law Association, as our
candidate for the post.

I would appreciate it very much if the candidacy of our nominee, together
with her CV which is attached hereto, would be brought to the attention of the
Committee of Ministers for consideration and, subsequently, for consultation of the
Joint Committee during the June session of the Assembly in 2015, in accordance
with the Regulations relating to the appointment of the Secretary General of PACE.

Yours sincerely,

Mr Thorbjern Jagland
Secretary General
Council of Europe
Strasbourg
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CURRICULUM VITAE

SVETISLAVA BULAJIC

1. PERSONAL DATA
Born on June 4, 1964
Sex: female

Children: one daughter (age 23)
National of Serbia

2. EDUCATIONAL QUALIFICATIONS

2.1. Universities attended and degrees obtained

University of Belgrade, Faculty of Law, Bachelor of Laws, summa cum laude, 1987.
University Paris I, Panthéon-Sorbonne, Master's program - auditenr libre, 1991.
University of Belgrade, Faculty of Law, MA, 1998.

University of Connecticut School of Law, LL.M, 2011.

University of Belgrade, Faculty of Law, Ph.D. approved candidate as of 2013 (expected time
frame for degree completion: autumn 2015).

2.2. Academic awards and scholarships

University of Belgrade. Faculty of Law, Undergraduate studies: high standard awards for every
academic year (1982-1987), rated among the top ten students on Dean’s Merit Lists

University of Belgrade, Faculty of Law, Postgraduate studies: University Academic Merit
Scholarship (1987-1990)

Institute of Federalism, University of Fribourg, Switzerland: EUROregions, European Summer
University and the Council of Europe grant (August 28- September 17, 1988)

University Paris 1, Panthéon-Sorbonne. Master’s program: French Government Scholarship
(1990-1991)

Salzburg Seminar: Session 307 - American Law and Legal Institutions - grant (July 25-August 6,
1993)
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University of Salzburg, Austria: Department of International and Foreign Public Law grant for
research on global menaces to democracy and human rights (May-June 1994)
University of Connecticut School of Law, LL.M program: Ron Brown Fellowship (1997-1998)

CEU. Budapest, Summer Program in Human Rights: CEU grant (July-August 1999)
University of lllinois at Chicago, Summer Program in Intemational Law: UIC grant (July 2000)

The Supreme Court Historical Society grant, Seminar on Federalism, Washington, DC (June
2002)

European Commission, Erasmus Mundus External Cooperation, Project Basileus (Balkans
Academic Scheme for the Internationalisation of Learning in cooperation with EU universities),
one month staff mobility program, University La Sapienza, Rome, Italy (October 2009)

Promoting Tolerance 2014 Program - the Friedrich Naumann Foundation for Freedom (FNF)
and the American Jewish Committee (AJC) program: seminar in Sofia, Bulgaria (Junc 2014) and
the study trip to US (October 2014)

3. LANGUAGE PROFICIENCY

- Serbian (native), incl. Croatian, Montenegrin and Bosnian
- English, French (fluent, full ability)
- Italian, Russian, Hungarian (working knowledge)

4, SKILLS AND ABILITIES

- proficiency in operating word processing cquipment
- pedagogical and rescarch experience

- managerial experience

- legal consulting experience

- expertise in facilitation and mediation

5. WORKING EXPERIENCE

5.1. Teaching Assistant, Department of Public Law. Belgrade University Fat.:ully of Law, 1989-
1998 (tcaching Constitutional Law graduate course — theory find comparative Iaw“as well as
seminars in legal theory related subjects, which included overviews of the history, philosophy of
law, and jurisprudence):

5.2 Senior Lecturer, Department of Public Law, Belgrade Univcrsity. l:'acully of ng, ‘l 998 1o
2015 (teaching Political Science Theory graduate course, as well as The Introduction into I{U
Law and Judicial Protection in EU, both postgraduate courses: current research agenda - EU
Institutional design);

I~
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5.3. IREX (International Research and Exchange Board), Washington, DC, Field Representative
for Serbia (former FR Yugoslavia), 1999 to 2003 (assisting in academic cxchange and
recruitment of both national and international candidates for programs taking place in US and
Serbia, i.e. Ron Brown Program, Fulbright scholarships, etc.):

5.4. CECL (Centre for European Constitutional Law), Rigas Network ~ Athens, Greece, Resident
Associate for Serbia (former FR Yugoslavia), 2000 to 2004 (preparing seminars, drafting policy
papers, compiling data base on relevant changes in domestic legislation, ctc.);

5.5. OSCE/ODIHR Election Observation Mission to the Republic of Serbia, Parliamentary
Elections 2000 (November 22 — December 30, 2000), Deputy to the Mission Lcgal Advisor;

5.6. OSCE Mission to Serbia and Montenegro, Media Department, Media Lawyer, March 2001 to
November 2005 (providing assistance in creating new media legislation framework, most notably
Broadcasting Law, Free Access to Information Law and Public Information Law; raising
awareness campaigns in co-operation with domestic media outlets and NGOs; promotion of the
idea and practice of free press and PBS through round-tables, theme and training seminars,
forming civic coalitions; fund- raising in above areas, ctc.);

5.7. FUND FOR OPEN SOCIETY. SERBIA, expert consultant on the *Monitoring of the process
of Serbian accession towards European Union” project. and editor of the publication “Capacities
of state institutions for undertaken accession obligations™. 2006;

5.8. MINISTRY FOR HUMAN AND MINORITY RIGHTS, SERBIA AND MONTENEGRO,

in co-operation with the Danish Institute for Human Rights, expent consultant on Legislative
Reform Project, 2006;

5.9. WORLD BANK, Country Office for Serbia, MDTF (Multi-Donor Trust Fund) in Justice
Sector Support Project, Expert Consultant, February 2008 to January 2011, providing insights and
advice to the World Bank task team on formulation and implementation of World Bank support
for justice sector reform in Serbia; reviewing and commenting on laws, regulations and other
documents pertaining to justice sector reform issues, including overseeing the sizeable budget
line; liaising on behalf of the task team with the Ministry of Justice, Serbia’s development
partners, academia and civil society entities dealing with justice sector reform; participating in
World Bank missions and following up with interlocutors inside and outside government on
issues identified/discussed during the missions;

5.10. UNIVERSITY OF CONNECTICUT SCHOOL OF LAW, Visiting scholar and Deputy
Director for International Programs, January 2011 to January 2012 (teaching Introduction into US

Law and Legal Institutions to foreign LL.M students, responsible for the administration of the
said LL.M Program and other international programs, including launching of the SJID Program).

6. OTHER ENGAGEMENTS

6.1. Expert advisor to the Vice-president of the Serbian Parliament Constitutional Drafting
Commission, 2003,

6.2. Member of the President of Serbia expert team for drafiing new Constitution, 2004-2005.
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6.3. Candidate-judge nominated to the Serbian Constitutional Court by the President of Serbia
(June 2005).

64 Member of the National Assembly of the Republic of Serbia - independent candidate for the
Liberal Democratic Party (May 31" 2012 10 June 16" 2014), and through that capacity a full
mcmbqr of the PACE - Parliamentary Assembly of the Council of Europe (member of the Legal
Committee and its Sub-Committee for the Election of the Judges of the European Court of

Human Rights: member of the Social Committee), as well as the clected Vice-President of the
Parliamentary Assembly of the Mediterrancan:

6.5.‘Member of various associations (member of the Serbian Constitutional Association
Presidency; Ron Brown Alumna, member of Fulbright Association of Serbia; member of ADEF —
Association des Diplomés de I'Ensignement Superiéur Frangais).

7. RELEVANT PUBLICATIONS

FREQUENTLY ASKED QUESTIONS, BROADCASTING LAW OF THE REPUBLIC OF SERBIA, OSCE
Mission to Serbia and Montenegro ed., Belgrade, 2003, 142 pp, in Serbian and English.

45 vears of the Constitutional Council of the French Fifth Republic, in Constitution as Lex
Superior, A Tribute to Profl. Pavle Nikoli¢, ed. Udruzenje za Ustavno pravo Srbije, Belgrade,
2004, in Serbian.

GUIDEBOOK ON FREE ACCESS TO INFORMATION LAW, Fund for Open Socicly Serbia ed.,
Belgrade 2005, 94 pp, in Serbian and English.

Law of Nationality and the Dissolution of Yugoslavia - paper presented at the Round Table
»Citizenship or Nationality? Dual Citizenship as A Legal Problem« held on October 3, 2005 in
Budapest at the Institute lor Legal Studies of the Hungarian Academy of Sciences and published
as a contribution to the Belgrade Law Faculty Project »The development of Serbian legal system
and its harmonization with EU Law, Belgrade 2005, in English.

On the QOccasion of the Adoption of the Draft Constitution of Serbia: Democratic
Constitutionalism and Constitutional Power, Serbian Legal Journal, no. 5, Pravni Forum ed.,
Belgrade 2006, in Serbian.

THE GUARDIAN OF FRENCIH CONSTITUTION, ed. ‘Sluzbeni Glasnik’, Belgrade 2006, 162 pp.
(http://slglasnik.com), in Serbian.

CAPACITIES OF STATE AND LOCAL ORGANS, MONITORING OF THE EU HARMONISATION PROCESS
IN SERBIA - SOCIAL, ECONOMIC, POLITICAL AND LEGAL ASPECTS, co-author and editor, Fund for
Open Society Scrbia ed.. Belgrade 2006, 142 pp. (hup:/www. fosserbia.org), in Serbian.

On the rermination of parliamentary mandate, with the emphasis on the termination caused by
the cessation of political party or coalition membership, Belgrade Law Faculty Project »The
development of Serbian legal system and its harmonization with EU Lawe«, Belgrade 2007, in
Serbian.



Doc. 13853 — Communication

Value jurisprudence in contemporary constitutional review: A challenge before Serbia, VII™
World Congress of the International Association for Constitutional Law, Workshop 15: Balancing
and proportionality in constitutional review, Athens, June 2007, in English.

Serbia in Europe — skeich for the diagnosis of condition, contribution to electronic journal Ewrope
plus, June 2008, http://www.cmins.org/sr/publikacije/cvropa-plus/arhiva/serija2/0806/04.himl, in
Serbian.

Historical background to the American controversy over originalist approach to constitutional
interpretation ~ lesson to be learned from, Belgrade Law Faculty Project »The development of
Serbian legal system and its harmonization with EU Law, Belgrade 2008, in English.

American Federalism and the EU Institutional Design Revisited, Belgrade Law Faculty Project

»The development of Serbian legal system and its harmonization with EU Lawg, Belgrade 2013,
in English.

THE CONSTITUTION AND THE RIGHTS OF CITIZENS, mandatory textbook for high-school students,
co-authored with professor S. Lilic, | ed. “Zavod za udZbenike i nastavna sredstva™, Belgrade
2006, 170 pp. (updated IV ed., 190 pp, Belgrade 2013), (hup:/www.zavod.co.rs - catalog of
publications), in Serbian.

ORIGINALISM, AMERICAN CONTRIBUTION TO CONSTITUTIONAL INTERPRETATION, Ph.D thesis
(expected time frame for completion: autumn 2015), in Serbian.
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Candidature of Mr Wojciech SAWICKI

The Secretariat recalls that, on 18 and 19 March 2015 (1223rd meeting of the Deputies, item 1.5), the
Deputies adopted the timetable concerning the procedure for the election of the Secretary General of the
Parliamentary Assembly. In that timetable 12 May 2015 was fixed as the closing date for the submission of
candidates and 2-3 June 2015 (1229th meeting of the Deputies) was fixed as the date for the preliminary
examination of candidatures by the Deputies.

On 24 March 2015, the Secretary General forwarded to the Committee of Ministers the candidature of
Mr Wojciech Sawicki, the current Secretary General of the Parliamentary Assembly.

The Secretary General appended to that communication a copy of the three letters addressed to him on
20 March 2015 by the following members of the Assembly (in alphabetical order) in which they proposed the
candidature of Mr Sawicki:

- Mr Pedro Agramunt, EPP/CD, Spain

- Ms Theodora Bakoyannis, EPP/CD, Greece
- Ms Gilsiin Bilgehan, SOC, Turkey

- Mr Christopher Chope, EC, United Kingdom
- Mr Andreas Gross, SOC, Switzerland

- Mr Tiny Kox, UEL, Netherlands

- Ms Stella Kyriakides, EPP/CD, Cyprus

- Ms Ingjerd Schou, EPP/CD, Norway

- Mr Piotr Wach, EPP/CD, Poland

- Mr Jordi Xucla, ALDE, Spain.

*kkkk

On 24 March 2015, the Secretary General forwarded to the Committee of Ministers the candidature of
Mr Wojciech Sawicki, the current Secretary General of the Parliamentary Assembly.

The Secretary General appended to that communication a copy of three letters addressed to him on
20 March 2015 by members of the Assembly in which they proposed the candidature of Mr Sawicki.

The present addendum contains the letter signed on 6 May 2015 by Mr Grzegorz Schetyna, Minister of

Foreign Affairs of Poland, also proposing the candidature of Mr Wojciech Sawicki for a second mandate as
Secretary General of the Parliamentary Assembly.

11
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Strasbourg, 20 March 2015

Dear Secretary General,

In accordance with the Regulations relating to the appointment of the Secretary General, Deputy Secretary
General and Secretary General of the Assembly, we would like to propose Mr Wojciech Sawicki, current
Secretary General of the Parliamentary Assembly, as candidate for the post of Secretary General of the
Parliamentary Assembly whose term of office will begin on 1 February 2016. You will find appended his
curriculum vitae.

We would be most grateful if you could forward this proposal to the Committee of Ministers for examination
and subsequent consideration on the occasion of the consultation with the Assembly in the Joint Committee
during the 2015 June part-session.

Yours sincerely,

Signed:

Pedro Agramunt, EPP/CD, Spain
Theodora Bakoyannis, EPP/CD, Greece
Gulsuin Bilgehan, SOC, Turkey
Christopher Chope, EC, United Kingdom
Andreas Gross, SOC, Switzerland

Tiny Kox, UEL, Netherlands

Stella Kyriakides, EPP/CD, Cyprus
Ingjerd Schou, EPP/CD, Norway

Piotr Wach, EPP/CD, Poland

Jordi Xucla, ALDE, Spain

Mr Thorbjgrn JAGLAND

Secretary General of the Council of Europe
Palais de 'Europe

STRASBOURG

12
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Warsaw, & May 2015

DNZPCZ.4011.1.20155 / MP

Dear Secretary General,

Having consulted you in accordance with the regulations relating to the appointment
of the Secretary General, Deputy Secretary General and Secretary General of the
Parliamentary Assembly of the Council of Europe, on behalf of the Government of the
Republic of Poland | would like to present the candidature of Mr. Wojciech Sawicki, the
current Secretary General of the Parliamentary Assembly, for the second term at the post of
the Secretary General of the Parliamentary Assembly of the Council of Europe. Please find
enclosed the curriculum vitae of Mr. Sawicki.

| would be most grateful if you could forward this candidature to the Committee
of Ministers for examination and subsequent consideration on the occasion of the

consultation with the Assembly in the Joint Committee during the 2015 June part-session.

Yours faithfully,

Mr. Thorbjgrn Jagland
Secretary General of the Council of Europe

13
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Curriculum vitae

Wojciech SAWICKI

Wojciech SAWICKI =
Secretary General of the Parliamentary Assembly -
of the Council of Europe

Since 1 February 2011
Secretary General of the Parliamentary Assembly of the Council of Europe

May 2006 — January 2011
Director General, Secretariat of the Parliamentary Assembly of the Council of Europe (deputy to the
Secretary General of the Parliamentary Assembly)

November 2009 — March 2010
Acting Secretary General of the Congress of Local and Regional Authorities of the Council of Europe

October 1996 - January 2011
Co-director of the European Centre for Parliamentary Research and Documentation

June 1996 — April 2006
Director (Deputy Clerk) - Head of the General Services Department of the Parliamentary Assembly of the
Council of Europe

- giving assistance to the Secretary General (Clerk) of the Parliamentary Assembly in all his

tasks, and replacing him if need be;

- responsible for the Interparliamentary cooperation work programme;

- responsible for coordination of committees’ activities;

- responsible for management of the Staff of the Secretariat, Administration and Finance.

February 1990 — May 1996
Secretary General of the Polish Senate.
- responsible for setting up and managing all aspects of the Upper House (Senate) of the Polish
Parliament’s day to day activities;
- providing political, legal and procedural advice to all statutory organs of the Senate;
- responsible for maintaining contacts with the secretariats of other Parliaments;
- co-ordinator on the Polish side for the implementation of long term assistance programmes by a
number of Western Parliaments.

October 1977 — January 1990
Programmer and Head of Department in the Power Industry Computer Centre — Warsaw, Poland.

- responsible for planning implementing and maintaining of computer operating systems.

1979 — 1986 - Outside lecturer for the Polish Academy of Sciences / Warsaw

Miscellaneous:

1990 to present
Association of Secretaries General of Parliament

- Member (since 1990)

- Member of the Executive Committee (1992-1996)
- Vice-President (1995-1996)

- Honorary Member (since 1996)

14
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1979 — 1996
Member of the Executive Committee of the Warsaw Club of Catholic Intellectuals;

- 1981-1984: Vice-president of the Club
- 1984-1990: Treasurer of the Club.

1980 — 1981 - Chairman of the “Solidarnosc” Trade Union Section at the Power Industry Computer
Centre.

1981 — 1987 - Member of the Church Committee to Assist (Political) Prisoners and their Families (set up
following the imposition of martial law in December 1981); Head of the Registry and Information Office of the
Committee, responsible for setting up and managing the information system of the Committee with more
than 18.000 entries.

Distinctions:

2011 - Commander Cross of the Order of the Polish Renaissance (Polonia Restituta)

2002 - Gold Cross of Merit (Poland)

Education - Warsaw University, Faculty of Mathematics and Computer Sciences —
M. Sc. In Computer Sciences specializing in operating systems (1978)

Languages - English, French and Russian
Nationality - Polish
Date of birth - 20 March 1955

Status - Married, 3 children
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